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Chapter 1 Introduction 

1.1 KEYKING - Overview 

KEYKING is a world’s leading manufacturer and supplier of Integrated Security 

Solutions (Access Control, CCTV, Intrusion, Car Parking) and Building Management. 

KEYKING meets the stringent requirements of end users for security, security, and 

user friendliness. KEYKING has a strong global presence providing its systems in 

more than 40 countries. If you are interested in our products, please visit our website 

www.keyking.net. 

1.2 Software Overview 

The Secusys Integrated Security Systems Software comprises a suite of software 

products that covers the complete range required by access control professionals. The 

software includes not only the Access Control base software itself, but also includes 

Intruder Detection, CCTV Management, Car Parking, Card Design and Print, Canteen 

and Guard Tour modules all integrated with the Access Control software. The 

licensing for these additional modules is by way of Hardware Key. This manual 

covers the Access Control base software itself plus all the modules unless indicated 

otherwise. If a function shown is not available in the software being used it is because 

the particular module is an optional module and has yet to be licensed and installed. 

1.3 Database 

The Secusys is Multi-Language and Multi-Database. During the installation process, 

the user is asked to select between languages. Users are also asked to select the type 

of database they wish to use. A Microsoft Access database is supplied for 

demonstration purposes and installer testing while Microsoft SQL is used for the end 

user. The two free SQL versions of Microsoft SQL are either MSDE which is used for 

Windows XP, or Microsoft SQL Server Express which is used for both the 32 bit and 

64 bits versions of Windows 7. However licensed installations of Microsoft SQL 

Server 2008 or later are preferred. 

1.4 Web & FTP Sites 

Although software is supplied on a CD or Memory Key at the time of purchase, 

http://www.keyking.net/
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because of enhancements and bug fixes, software very quickly goes out of date. To 

make it easier for the installer, up to date software is located on the Secusys FTP site 

which is accessible to installers through the main Secusys web site. 
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Chapter 2 Software Installation 

2.1 Hardware Requirements 

The Secusys is integrated Access Control, CCTV and intruder system, designed to run 

on a Microsoft Windows platform. The software is designed to run on either 

Microsoft Windows 10, or 32 bits/64 bits version of the Windows 7 operation system.  

The following is the minimum computer requirement: 

➢ CPU: Intel Core 2.67 GHz 

➢ Free 20G bytes Hard Disk space 

➢ RAM : 4G bytes 

➢ VGA : 1024 x 768 pixels  

➢ One free USB Port 

2.2 Secusys Installation for Windows 

Power up the computer and start Windows. 

Insert the setup CD or the USB memory key containing the software. 

Double Click on the “My Computer” icon and select your CDROM or your USB 

drive. 

Two files will be visible, a small text file called “SN.txt” and an exe file called 

“Secusys3.2.2.33_NoCardList_20240110.exe”. 

 

Figure 2-2-1 

It is strongly recommended that a “Security” directory is created on C Drive and 

these 2 files plus any other security related files are saved to this folder. The 

installation is then undertaken from this folder. 

 

Installation Steps: 

Note: 

Before installation, you’d better install SQL such as SQL2012, SQL2008. 
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⚫ If you have installed SQL before Secusys, the Secusys will attach the 

database automatically when you run Secusys at the first time. 

⚫ If you have not installed SQL before Secusys, you need attach the database 

manually. 

⚫ After you install SQL, please install the plugs/patch for it according 

Microsoft mentions. 

⚫ Secusys2000 database is the default name in SQL, and will take the user (sa) 

and PIN (secusys) is default user (sa, secusys) to access SQL. 

 

Double click on the “Secusys3.2.2.33_NoCardList_20240110.exe” file, allow the 

program to run, and the setup screen will appear. Click “Next” to continue. 

 

Figure 2-2-2 

Agree to the terms of the License Agreement and click “Next” to continue. 
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Figure 2-2-3 

Enter your name and company then click “Next” to continue. 

 

Figure 2-2-4 

Click “Next” to continue at the list of compatible controllers. 

2.2.1 Model numbers supported 

 

 

Figure 2-2-5 

2.2.2 Serial Number 

A serial number is required to proceed. 



 6 

 

Figure 2-2-6 

Open the SN.txt file and the Notepad screen will appear. Copy and paste the serial 

number into the software. 

 

Figure 2-2-7 

 

Figure 2-2-8 

Installation Options: 

Note: Please read the options carefully, and choose what you want. 
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2.2.3 Installation as a Server 

Server / Client Option: 

Server / Client for this computer: 

 

The software can be installed either as a Server or a Client. The first installation must 

be the Server. Make sure that Server is selected then click “Next” to continue.  

 

If you install Secusys at the first time, you may use it as a server, please just 

keep the default setting. 

If you install Secusys server in another computer, now this computer will 

connect to the server, just keep the default settings. 

 

2.2.4 Length of Card Number 

This option is so important for you, because you have to know which kind of 

card you are using for the system. If you have questions, please contact with 

your supplier. 

Length of Card Number:  
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2.2.5 License Type 

 

Installed in Virtual Machine – No License Dongle 

 

 

2.2.6 Enable Administrator Privileges 

Enable Administrator Privileges 

 

 

Note: Please read the options carefully, and choose what you want. 
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Figure 2-2-9 

2.2.7 Function/Application Module 

Select the features that are required. For the Base Access Control modules then this 

will normally be the 1st option only. 

 

Figure 2-2-10 

Click Next to install the software into the default directory or change the path then 

click Next. 
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Figure 2-2-11 

Click Next to accept the default folder. 

 

Figure 2-2-12 

Click Next to proceed. 

 

Figure 2-2-13 
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The initial software will install in 2-3 minutes and click OK to finish the installation. 
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Chapter 3 System Setup 

3.1 Notes for Windows Operating Systems 

If Microsoft Windows 7 is being used then Microsoft .NET and Microsoft Server 

Express 2008 must have been downloaded and installed prior to running the Secusys 

software. 

The bundled SQL Database, MSDE, is not compatible with Windows 7. 

Windows 7 uses “User Account Control”. User Account Control should be turned off 

when running the Secusys Integrated Security Systems software. To turn off User 

Account Control go Start, Control Panel, System & Security, Change User Account 

Control Settings. Move the slider to the “Never Notify” position then click OK. 

 

Figure 3-1-1 

3.2 Run Secusys 

Click on the “Secusys3.2” Desktop Icon to load the software.  

 

Note: 

⚫ First Running Secusys will take a few seconds or so while, because the 

software attempts to connect to the default database.  

⚫ Allow the Secusys in Windows Firewall to access Private and Public 

networks. 
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Figure 3-2-1 

3.3 Open 

Main 

Interface 

The software Secusys3.2 is protected by a USB Hardware Key which must be inserted 

into a USB port before the software loading. If the hardware key has not yet been 

plugged into a USB port on the same computer, it will be a demo version. 

 

Figure 3-3-1 

Login with the default “Administrator” user and input the default password “secusys”, 

click OK to open the main interface of the Secusys3.2. 

 

Figure 3-3-2 



 14 

The Secusys software main screen will now appear. 

Once logged in, the main interface window will appear. This window has a menu bar, 

a shortcut menu, and a controller manager. In addition, it displays authorized users 

and current users, as well as whether the computer is acting as a server or client. 

These items are explained in more detail in the following sections. 

 

 

Figure 3-3-3 

3.3.1 Server/Client 

The Secusys software can be run in either Server or Client mode. The initial 

installation will be the “Server” as the server contains the actual database. Subsequent 

installations on other computers will be “Client” and these client computers will 

always connect to the database on the server. 

 

Figure 3-3-4 

Software running as a server or a client 

Menu Bar 

Shortcut menu 

Controller manager 

Current user 

The company that the  

software is registered to  
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3.3.2 Menu Bar 

The Menu Bar allows access to the entire program via a series of Sub-Menus. 

 

Figure 3-3-5 

3.3.3 Shortcut Menu 

The Shortcut Menu contains the most commonly used icons.

 

Figure 3-3-6 

3.3.4 Controller Manager 

The Controller Manager offers a quick way to access the Map Tree, the Intrusion Tree, the Access 

Tree and the CCTV Tree. Selecting the required item will open the respective window. 

3.3.5 Bottom Notification Bar 

The bottom Notification Bar shows four different items TCP Listen means that the TCP Port is 

opened and listening for TCP/IP communications from TCP/IP enabled panels. Desktop Reader: 

False = There is no desktop card reader attached to this computer. User is the current user that is 

logged on, in this case it is the Administrator. The Legal User is the company or user to which the 

hardware key is registered to. As a note users should have individual logins as user tracking is 

undertaken using these logins. 

 

Figure 3-3-7 
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Chapter 4 Management Menu 

Select “Management” from the main Menu Bar to bring up the Management sub menu. 

 

Figure 4-0-1 

4.1 Client Manager 

Add client computer for client to logon on  

 

Figure 4-1-1 

 

4.2 User Manager 

The User Manager is a separate program that is normally accessed via the start menu. However 

clicking the User Manager option opens the User Manager program via a shortcut. A password 

screen may or may not appear depending upon the login rights of the current operator. If it does 

appear the default User Manager password is “secusys”. 
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The Secusys software allows multiple users (software operators) simultaneously and can give each 

user a different level of access. Only the System Manager (Administrator) can add or delete the users 

and modify/add/delete the permissions of users. It is important for the installer to set up individual 

users, as user logging is achieved through the individual users. The password length can be up to 20 

digits and include any keyboard characters. Note that a user cannot edit themselves. 

Clicking on the User Manager sub menu item opens the main User Manager screen Note that initially 

there is only a single user called “Administrator” with an “Administrator” Permission Set. 

 

Figure 4-2-1 

Prior to creating a User, a Group that the user belongs to needs to be setup. There are 5 default 

groups already setup: Access Control Users, Accounts Managers, Administrators, Guests and 

Security Guards. Every User needs to belong to a Group. The Group grants the privileges as to the 

operation functions that the User will be able to undertake. Also when defining a User the 

controllers/doors and departments/sub departments which are inherited from the Group are 

specified. 

 

Figure 4-2-2 
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4.2.1 Adding a Group 

To Add a group select the “Group” list on the left panel and click the “Create a New Group” button, 

The New Group screen will open. 

 

Figure 4-2-3 

 

Figure 4-2-4 

Enter details for the new Group. Note that existing Users may be added to the Group. 

 

Figure 4-2-5 

Select the “Group” list and then click the “New” icon 
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Once a group has been created it can be edited, refer to the next section, Section 4.2.2. 

4.2.2 Editing a Group 

After creating the Group, Privileges need to be set up. Double-click on the Group to be edited in the 

right hand panel (or right click, properties) and the Group Properties screen will appear . 

 

Figure 4-2-6 

Currently this Accounts Manager group has a member “administrator”. Click on the Group Rights 

tab and the Group Rights screen will appear. 

  

Figure 4-2-7                        figure 4-2-8 

The Group can have different types of Rights (Privileges): User Account, Secusys3.2 Integration 

System, Time & Attendance, Canteen, Guard tour, Meeting Attendance and Reservation Access. 

User Account means the new Group members will be able to use the User Manager module for 

creating other Groups/Users and granting them privileges (the same module we are in now). 
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Secusys Integration System means granting the Group the privileges to each one of the 

Secusys3.24.3 software features (configuration, operation and monitoring). 

Time & Attendance, Canteen, Guard tour, Meeting Attendance and Reservation Access mean 

that the users will have access to these additional modules. 

Please note you will need to expand the Tree to tick each one of the check boxes. It’s not enough 

just to tick the root check box. Please select the Rights (Privileges) you would like to grant. 

 

Figure 4-2-9 

4.2.3 Adding a User 

Select the “User” list on the left part and click the “Create a New User” button. 

 

Figure 4-2-10 

The New User screen will appear. Enter a user name and their password then their password again 

to confirm. The password length can be up to 20 digits and include any keyboard characters. 

Select the “User” and then click the “New” button 
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Figure 4-2-11 

4.2.4. Editing a User 

Double click the user or select the user and click the “Properties” button, the following screen will 

appear. 

 

Figure 4-2-12 

Fill in the information in the General tab, select the Group that the User will belong to in the 

“Belong To” tab. Note that a User can belong to more than 1 Group. Tick the Departments and Sub 

Departments the User will be able to control in the Department Rights Tab. Please note that Ticking 

the Departments check box is not ticking also its Sub Departments check boxes. A User can be 

granted the privileges to control only certain departments. 
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Figure 4-2-13 

4.2.5 Deleting a Group or a User 

Selecting the Group or the User and clicking on the “Delete” icon will remove the Group or the 

User. 

When Deleting a User, there are 2 options: 

1. Logout User: remove the User from the User Manager but keep it in the Database. This means 

that this Users records can be viewed in the System Log. 

2. Delete User: The second option is to remove the User completely from the Database. 

 

Figure 4-2-16 

4.2.6 Changing User Password 

Select a User and then right click on Operate \ Setting Password to change a User Password. 
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Figure 4-2-17 

4.2.7 Exporting Groups List 

Highlight one or more groups and click “Operate” then “Export List” to export the Groups list to a 

MS-Excel file or a TXT file. 

4.3 Change Password 

To change the password of the current user, select “Management” then click “Change Password”. 

The Change Password screen will appear. Input the old password and the new password, then input 

the new password again for confirmation and click “OK”. 

 

Figure 4-3-1 

4.4 Department 

Select “Management” on the main menu bar then choose “Department” from the sub-menu. Clicking 

on the File menu in the resulting screen will allow additional departments or sub departments to be 

set up, an existing department to be deleted or to be edited. 
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Figure 4-4-1 

Departments may also be further divided into Sub Departments if required. When clicking “New 

Department” then a sister Department will be created. When clicking “New Sub Department” a Sub 

(child) Department will be created. If a company has multiple sites then each site can be a 

department, and each site department will be a Sub Department. Secusys software is guiding the user 

to begin the configuration from the general setup to the detailed one. This way the setup is performed 

structurally and easily. Before adding new Personnel to the system company structure can be 

designed first while grouping the Personnel to Departments. 

4.5 Group Management 

Clicking on the Group Management sub menu item will bring up the Group Management screen. 



 25 

 

Figure 4-5-1 

4.6 Installation Site 

Clicking on the Installation Site sub menu item will bring up the Hardware Installation Site 

Manager. You can add a new place or sub place and put the controllers in different site. 

 

 

Figure 4-6-1 

4.7 Change Database 

Clicking on the Change Database sub menu item will bring up the Database Link Wizard. Note that 

this is the same screen that appears initially on installation so refer to the setting of database if the 

database type is to be changed. 
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Figure 4-7-1 

Take the MS SQL database as a example. Click next to proceed. 

Select or enter a server SQL database, then enter information to log on the SQL server, and you can 

see all the database in the PC server, choose " Secusys2000", 

click "Test Connection", and you can get attention that the database connection tested successfully. 

 

Figure 4-7-2 

 

Figure 4-7-3 

4.8 Dictionary 

Clicking on the Dictionary sub menu item will bring up the Dictionary screen. The Dictionary 
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contains both present and user defined fields. The user defined fields allow the user to customize 

fields and their content in the Personnel Information, Basic Information tab. 

 

Figure 4-8-1 

The shortcut bar contains the following icons: 

Add Item, Delete Item, Edit Item, Save, Cancel, First Item, Prior Item, Next Item, Last Item, 

Preview and Close Current Window. 

 

Figure 4-8-2 

4.8.1 The File Tab  

From the Manage Dictionary sub menu item, click “File, Dictionary” to bring up the “System 

Dictionary” Window.  

 

Figure 4-8-3 

The following notes are with reference to the main Dictionary window. 

Different users might want to display different information in the Personnel Information Interface. 
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The different information headings can be configured in the System Dictionary. 

The items in System Dictionary are fields from the Personnel Information. These field names cannot 

be changed but the information in these fields can be changed. On the right side, under “Item 

Name” the value can be edited or changed or a new value created.  

For example, “Position” is a defined field name and cannot be changed. But the type of position or 

occupation can be. The default occupation values include “Director, Manager, Software Engineer, 

Hardware Engineer”. To create a new occupation within the Position field, select File/Add or 

alternatively click on the first Icon. Once added the new occupation is visible once Position has 

been highlighted. 

Click “File, Customized” to bring up the “Customized Dictionary” Window. 

 

Figure 4-8-3 

Unlike the System Dictionary, the Customized Dictionary allows the user to add completely new 

fields and their values to the Personnel Information, Basic Information tab. 

The entries CustomDict1..CustomDict5 allow adding up to 5 new fields each one with a pull down 

menu. 

The entries CustomField1..CustomField5 allow adding up to 5 new fields with free text to enter (not 

menu). 

For Example: A user might want to add “Work Experience” into Personnel Information. 

CustomDict1 can be modified to “Work Experience”, and then a tick placed in the “Visible” box to 

make the new field visible. 
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Figure 4-8-4 

Once the setup is complete, the “Work Experience” field will be added to the default Personal 

Information screen and now appear as a new field in this screen. 

 

Figure 4-8-5 

4.8.2 The View Tab 

From the Manage Dictionary sub menu item, click “View, View Fields, Fields Setup” to bring up 

the “Fields Setup” Window. 
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Figure 4-7-7 

The Field Setup window allows a user to change the order among the other fields or hide it 

completely. The other functions such as running a filter, locating a value and printing can also be 

undertaken from this View menu. 

4.9 System Management 

Clicking on the System Management sub menu item will bring up the System management window. 

The System Management screen consists of seven tabs, Uniqueness Inspect, Events View/Alert 

Range, Screen Saver, Photo Viewer, Area Viewer, Card Validity and Other Options. 

 

Figure 4-9-1 
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4.9.1 Uniqueness Inspect 

The Secusys3.2 software provides 2 fields named ID Number and Person Code in the Personnel 

Basic Information section. An ID Number is usually the Personnel ID Card number or Passport 

Number given by the government, or a company ID number. The Person Code is a free field which 

the user can use for any other purpose. In some cases when interfacing with 3rd party T&A software, 

the unique identifier given to the employee of the T&A software can be given to Secusys3.2 

employee as “Person Code”. This makes the interaction between the Secusys and the T&A 2 

software easier. In the System Management Uniqueness Inspect tab, there are options to define. if 

the fields must be unique, meaning the software will not allow you to enter 2 employees with the 

same Person Code or ID Number. 

 

Figure 4-9-2 

4.9.2 Events View/Alert Range 

A User can define the range of Events and Alerts presented on the Secusys3.2 monitors, that is the 

“Events monitor”, the “Multi Site View monitor” and the “Controller Manager” monitor. 
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Figure 4-9-3 

The following are the available options for the Events Monitor Range. 

Display localhost controller event: Only events from controllers which are connected to the PC that 

is running Secusys3.2 will be presented. 

Display these hardware that current operator has right events: Will present events only from 

controllers which are connected to this PC and that the user (see User Accounts, e.g. Administrator) 

has the privileges to monitor (the controllers). 

Display all events: All controllers events information will be presented in Secusys3.2 including the 

server controllers and the client controllers. 

 

Figure 4-9-4 

The following are the available options for the Events Alerts Range. 

Alert localhost hardware events: Only Alerts from controllers which are connected to the PC 

which is running Secusys3.2 will be presented. 

Alert these hardware that current operator has right events: Will present Alerts only from 

controllers which are connected to this PC and that the user (see User Accounts, e.g. Administrator) 
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has the privileges to monitor (the controllers). 

Alert all events: All controllers Alerts information will be presented in Secusys3.2 including server 

controllers and client’ controllers. 

 

Figure 4-9-5 

The following are the available options for the Hardware Management. 

Display localhost hardware: Will display only the controllers which are connected to this PC. 

Display these hardware that current operator has right: Will display only the controllers which 

are connected to this PC and the user (see User Accounts, e.g. Administrator) has the privileges to 

monitor (the controllers). 

Display all hardware: Will display all controllers of the server and all clients. 

 

Figure 4-9-6 

The following are the available options for the Cards/Area changed Personnel Range. 

Display these personnel that current operator has right: Only display these personnel that 

current operator has rights. 

Display all personnel : Will display all personnel. 

 

Figure 4-8-7 

The following are the available options for the Hardware list view style: 

Classic Style Computer and Address Style Installation site. 
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Figure 4-8-8 

4.9.3 Screen Saver 

Screen Saver is a protection program for Secusys3.2 Software, when the user left away from the 

computer, the Software will lock automatically. 

 

Figure 4-9-9 

4.9.4 Photo Viewer 

The following are the options of setting time about windows display when the user brush the 

parking card. 
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Figure 4-9-10 

4.9.5 Area Viewer 

The option page can be set up the area viewer, the content of the active rolling subtitles, the video 

recording, etc. 

 

Figure 4-9-11 

4.9.6 Card Validity 

The page can be set up card validity the user whose card is about to expire. 
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Figure 4-9-12 

4.10.7 Other Options 

In the following page, the user can check the function whatever you want. 

 

Figure 4-10-13 
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4.11 Holiday Settings 

Clicking on the Holiday Setup sub menu item will bring up the Holiday Setup main screen. 

 

Figure4-10-1 

To add a holiday, click File/Add Enter the details and click OK. Once added the holiday will appear 

in the list in the main Holiday Settings screen. As well as adding a holiday, the File menu can be used 

to Edit or Delete a holiday. 

 

Figure 4-10-2 

4.11 Daylight Saving Time 

Daylight Saving Time can be setup using the Summer/Winter sub-menu of the Manager menu. Using 

the dropdown menu of Time 1, set the month then the day that Summer/Winter time begins and the 

number of minutes that the time will be advanced. Note for Southern Hemisphere countries, daylight 

saving commences around March when the clocks are put forward 1 hour then reverts to standard 

time in September when the clocks are put back (Spring forward, Fall back). In the below example, 

the clock has been put forward by one hour on the 20th March then reverts back 1 hour on the 20th 

September. 
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Figure 4-11-1 

4.12 Export Active Directory 

It is used to add person through Active Directory, ADD the correct Path. 

    

Figure 4-12-1 
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Chapter 5 Setup Menu 

The setup menu allows an installer to setup the entire system ready for the end user. There are many 

items in the Setup menu list. The major sections here are the Setup Hardware and Setup Cards menus 

and these are placed at the top in a logical order for system setup. 

 

Figure 5-0-1 

5.1 Hardware 

There is no theoretical limitation to the number of devices that can be managed by the Secusys3.2 

software, the number is infinite. However there is a practical limitation and that is not related to the 

number of controllers be it 1000, 2000 or more, but to the number of events, the size of the database 

and the speed and quality of the network. For the larger type system then liaison with the IT 

department from the early stages will result in a more trouble free installation. 

 

Figure 5-1-1 
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5.1.1 Controller Configuration 

Clicking on the Controller Configuration sub-menu item on the Setup, Hardware menu will open the 

Controller Configuration screen Currently there are no controllers connected. 

 

Figure 5-1-2 

5.1.1.1 Searching for a Controller 

It will be easy to add a access controller in Secusys3.2 by Searching. Before Searching, you have to 

let the access controller connect to this PC, please refer to 5.1.2 TCP/IP setting. 

Steps: 

⚫ Click the “Search”, then the  Controller list will be showed on the right side. 

⚫ Chose the access controller you would like to save. 

⚫ Click “Save”. Done. 
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Figure 5-1-3 

Secusys controllers can be connected either through a Serial Communications Port (COM Port) or 

through an IP address. 

USB to RS-232 Serial Adapters (Old technology, not popular now) 

Most modern computers do not come standard with a serial port. Secusys recommends the purchase 

of a Serial Port Card for the computer which is inserted inside the machine. Most laptops have a 

PCMCIA or Express slot where a Serial Port Card can be inserted. Secusys does not recommend the 

use of portable USB to RS-232 converters. Many of these devices in the market are unstable and do 

not offer a true RS-232 Port. However if a portable USB to RS-232 adapter is used then please refer 

to section 3.9 for instructions on how to find the Com port number that Windows has allocated to this 

device. In this section when reference to a Serial or Com port is made this means either a onboard 

RS-232 serial communication port or a USB to RS-232 serial communications adapter. 

Searching controllers connected to a COM port (Old technology, not popular now) 

There are two options for the connection of controllers to a serial port. If the controller is located 

within 15m (50ft) of the computer then the RS-232 protocol can be used to connect the controller to 

the serial port. In this configuration only a single controller is allowed. The 2nd option is to use a 

serial to RS-485 adapter. The two advantages of a serial to RS-485 adapter is that the 15m (50ft) 

limitation of RS-232 is extended to 1200m (4000ft) and the single device limitation of RS-232 is 

increased to 127 devices. 

Searching Controllers over an IP address (popular technology, common) 

There are two options for the connection of a TCP/IP network to a controller. The 1st option is when 

using the Secusys V4 controllers and this is to use an external TCP/IP to RS-485 adapter. This allows 

a single IP address to control up to 127 controllers. The 2nd option is to use the Secusys V4 hardware 
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controllers with their built in 100M Ethernet connection and in this case each controller will have its 

own IP address. 

The 1st step is to select TCP/IP instead of a Com Port from the top left corner of the “Search and 

Upload Controller” screen. Note that the IP address of a controller or converter must first be listed in 

the IP address list as listed below the 0.0.0.0. If the device is not listed then the controller will not be 

found. If a TCP/IP device is connected to the same network and it does not appear in the list then 

proceed to Section 5.1.2 prior to searching for controllers. 

 

Figure 5-1-4 

In total we were found on the 192.168.7.105 IP address. 

 

Figure 5-1-5 

Click Save and then Close. The controller will be listed in the Controller Configuration screen. 
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Figure 5-1-6 

5.1.1.2 Adding a Controller 

As an alternative to searching for controllers automatically, the user can add a controller manually. 

Click on the “Add” button from the main Controller Configuration screen and the Add Controller 

screen will appear. Click on the dropdown menu to select the controller type then enter a name for 

the controller. This controller name can be a maximum of 30 alpha-numeric characters. Enter the 

COM Port or the IP Address and Port which are in use. Note that the controller hardware IP switches 

must be configured before controllers are added. 

 

Figure 5-1-7 

5.1.1.3 Deleting a Controller 



 44 

To delete a controller, highlight the controller to be deleted then click on the Delete button. Click 

“OK” to confirm deletion. 

 

Figure 5-1-8 

5.1.1.4 Editing a Controller 

To edit a controller, highlight the controller to be edited then click on the Edit button and the Edit a 

Controller screen will appear. 

 

Figure 5-1-9 

5.1.1.5 Refresh a Controller 

To refresh the displayed status of all the controllers, click on the Refresh button (figure 5-1-6).  

5.1.1.6 Download a Configuration 

To download the current secusys2000 database settings and configuration from PC to a specific 

controller highlight the controller then click on the Download button (figure 5-1-6). 

5.1.1.7 Download Config to All (Local) 
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To download the current Secusys2000 database from PC to all controllers which are connected to the 

PC click on the “Download Config to All (Local)” button (figure 5-1-6). 

5.1.2 TCP/IP Setting 

⚫ Click the Setup ---TCP/IP setting of Menu, to run TCP/IP setting to search all device. 

⚫ Click “NET” to run TCP/IP setting from Search and Upload Controller. 

 

Figure 5-1-10 

These TCP/IP access controllers will be listed on right side. If you uncheck “Do not show existing 

devices” box, these existing devices will not appear here.  

 

Figure 5-1-11 

TCP/IP settings: Let the device connect to the Host/PC running Secusys. 

Click “NET” to run 

TCP/IP setting 
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Manual Configure:  

Choose a device, and double click it. Input all information including IP, Mask, Gateway, and Host 

IP...  

 

Figure 5-1-12 

Please make sure the dip switches (IP protection) be ON position. 

Any device will have below items: Mac Address, IP, Mask, Gateway, and Host IP. 

Auto Configure:  

Choose a device, and double click it. Click “Auto Config” to configure this device automatically 

including IP, Mask, Gateway, and Host IP. 

 

Click “NET” to run TCP/IP setting 
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Other Functions: 

Search: Search again for Mac addresses. 

Manual Configure: Configuring the IP address manually by setting each of the parameters 

Auto Config: Secusys3.2 will configure the IP address automatically 

Wizard: Starts the configuration wizard 

Reset: Restart the converter module 

Reset All: Restart all the converter modules 

Connect Controller: If the module client has been changed from the TCP Client default to TCP 

Server (see below) then this option is used to connect controllers 

Connect All Controllers: See Connect Controller above 

Exit: Exit the dialog box 

If the user selects Manual Configuration the TCP/IP dialog box will open. An explanation of items in 

this box follows: 

Mac Address: A unique identifier embedded in the network adapter (the TCP/IP module) 

Name: Controller name which can be a maximum of 30 alpha-numeric characters 

IP Address: The IP address the controller will have 

Mask: The Network Subnet Mask 

Gateway: The Default Gateway 

Port: TCP/IP Port, can be between 1024-65535, default is 8000 

Work Mode: Normally set to TCP Client however for some special applications may 

need to be set to TCP Server. Only change on instructions from a Secusys 

engineer 

Host IP: The IP address of the PC which is connected to the controllers through 

TCP/IP 

Host Port: Can be between 1024-65535, default is 8000. Do not change this unless 

instructed by a Secusys engineer 

5.1.3 Search Controller 

Clicking on the Search Controller sub-menu item on the Setup, Hardware menu will open the Search 

bword://!!ARV6FUJ2JP,unique%20identifier/
bword://!!ARV6FUJ2JP,network%20adapter/
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Controller screen. Note that this is the same screen as described in Section 5.1.1, Controller 

Configuration. Refer to “Searching for a Controller” under Section 5.1.1 for information on this 

option. 

5.1.4 Doors Configuration 

Click the Door Configuration sub-menu item on the Setup, Hardware menu will open the Door 

Configuration screen. The Door Configuration screen consists of 6 tabs: Parameters, Door Status 

Time Table, Door Access Time Table, Personnel Access Level, Event Driver and Channel Mapping. 

 

Figure 5-1-13 

5.1.4.1 Parameters 

Both Door and Reader parameters can be set up from within this screen. 

Door Parameters: This is where any general function related to a specific door is set up . To 

commence setting up a door, first highlight the door from the list of controllers and doors on the left 

hand side. Once the specific door has been highlighted, the items for that door can be configured as 

follows: 

Door Code:           Remained 

Door Name: Type the name of the door. 

Door Type: An IN reader only or an IN/OUT reader. (On some models this field will 

be preset). 

Door Sensor: Normally Open or Normally Closed. 
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Exit button: Normally Open or Normally Closed. 

Lock Open Time: The relay unlock time, normally 5 seconds. 

Lock Monitor Time: The time before an alarm, normally 30 seconds. It is used to make sure 

that the door is not left open for a long time by putting an obstacle 

between the door and the door frame which prevents the door from 

closing. 

Read Card Mode: Single valid card or multiple valid cards needed for unlocking the door. 

Multi Card: The number of valid cards that need to be flashed for unlocking the door. 

PIN Required: Select Enable to enable door PIN access. 

Max. 3 wrong PIN: If enabled and an incorrect PIN is entered 3 times, the software will delete 

the access level of the card. 

Duress PIN: A fixed duress PIN number for this door (4 digit PIN). 

Super PIN: If enabled, the door can be opened with a PIN only by entering 

*12345678# where 12345678 is the Super PIN. 

 

Reader Parameters:   This is where any general function related readers are set up 

LED Control: Normally Cathode. 

Buzzer Control: Normally Cathode. 

Reading Delay: The shortest time interval between reading 2 different cards. 

Keypad Delay: The shortest time interval between 2 digits being entered at a keypad. 

Wiegand Reader Type:   Keyking or Face Recognition or HID  

 

Area APB: Select Enable for Area Anti Passback. 

Exit Area: Exit Area for Anti Passback. 

Entry Area: Entry Area for Anti Passback. 

Area Name: Click this button to give an area an alpha numeric name. 

Door configuration can be copied from one door to another on the same controller. There are 2 “Set 
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All” buttons. The left hand “Set All” button copies only the tab that is open at the time. The right 

hand “Set All” copies all 5 tabs. 

 

Figure 5-1-14 

5.1.4.2 Door Status schedule 

This is where the Time Tables for a specific door are set up. There are 32 available time tables per 

door. 

 

Figure 5-1-15 

Highlight a Time Table then click on the “Edit Status” button to bring up the Status Time Set screen. 

On this screen, the actual status for the door can be set up. Enter the Start Time then click on the 

Copies the entire configuration of the 

source door to the target door 

 

Sets the configuration of the selected 

door to all doors of the selected 

controller for all 6 tabs 

 

Sets the configuration of the selected 

door to all doors of the selected 

controller for just the current tab 
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arrow next to the Entry Status label to select a status. Options are: 

Opened from 1st card: door opens with the first card. 

Normal:  Door opens normally with the presentation of a valid card. 

Sleep: The system is effectively asleep and will not read a valid card. 

Always Open: The door is always open (unlocked). 

Always Closed: The door is always closed (locked) but can be unlocked with a super card. 

Card + PIN: Card and PIN required. 

APB: Anti Passback. 

 

Figure 5-1-16 

Tick the days of the week to apply the chosen status for. The H1-H7 boxes refer to the seven types of 

Holidays that can be set up (Section 5.2) and the T1-T2 boxes refer to the two types of Temporary 

dates that can be configured (Section 5.1). 

5.1.4.3 Door Access Schedule 

The Door Access Time Table sets the Time Tables for Door Access and is configured similarly to the 

Door Status Time Table (Section 5.1.4.2). At the Door Access Time Table, the End Time is also 

configured. Each door can have up to 15 different Time Tables while each Time Table can have up to 

7 different Time Zones. The Time Zone will set the days and time period for the door access 

(meaning valid cards can open this door during that time for example). Different Time Zones can 

have different days and hours. 
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Figure 5-1-17 

5.1.4.4 Personnel Access Level 

Access levels (Time Table) can be set up within this screen by right clicking the value in the “Time 

Table” column. A user can also set up access levels using the Access Levels sub menu option on the 

Setup, Cards menu where access levels, departments, sub departments, and personnel can be copied 

and pasted. 

 

Figure 5-1-18 

5.1.4.5 Channel Mapping 
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In this screen, input the channel IP and it can be set up channel mapping with the door and DVR. 

 

Figure 5-1-19 

5.1.5 Previously Time & Attendance Controller 

Clicking on the Previous Time & Attendance controller sub-menu item on the Setup, Hardware menu 

will open the T&A controller screen. The T&A controller’s property (backlight, event full alarm, 

network switch) can be set up. 

 

Figure 5-1-20 

Some characters can be set up by editing the new words. The normal display is “welcome use!”. 

Click “edit” and new display can be input in the blank. Then click OK and we have added a new 

display successfully. 
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Figure 5-1-21 

 

Figure 5-1-22 

 

Figure 5-1-23 

In the time screen, click “edit” or double click the clock flag to set up a clock time. 
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Figure 5-1-24 

 

Figure 5-1-25 

Click OK to save the setting. 

 

Figure 5-1-26 

5.1.6 Controller Components 

Click the Controller Components sub-menu item on the Setup/Hardware menu will open the 

Controller Components screen. A Controller Component is any of the controller components (Door, 
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Lock, Door Sensor, Exit button, Aux Input, Aux Output or Reader). These components can be 

renamed by highlighting the Component, right click then selecting Rename or click the Rename 

button. 

 

Figure 5-1-27 

Depending upon the type of Component, other functions are available. For example, highlighting on 

a door, then right clicking will bring up a menu that allows the user to force open the door manually. 

Right clicking on a door sensor allows the door status to be changed. 

 

Figure 5-1-28 

Using the Controller Manager or the Multi Sites View allows similar control but with a more 

graphical and easier interface. 

5.1.7 Preset Components Status 

Clicking on the Preset Components Status sub-menu item on the Setup, Hardware menu will open 
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the screen. 

 

Figure 5-1-29 

Check the controller with IP 192.168.7.105, click the file to add a new preset components status. 

Click OK and the new action add to the preset components status. 

 

Figure 5-1-30 

5.1.8 Intrusion Panel Configuration 

Clicking on the Intrusion Panel Configuration sub-menu item on the Setup, Hardware menu will 

open the Intrusion Panel Configuration screen, currently there are no panel connected. 
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Figure 5-1-32 

The Secusys 3.2 software allows the user to avoid the need for manually adding and configuring 

intrusion panel by doing this automatically. Click the “Search” button from the bottom of the 

Controller Configuration screen to open the “search intrusion panel” window. 

 

Figure 5-1-33 

Click Search to find intrusion panel in the right screen. Currently there is a panel connected. 
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Figure 5-1-34 

Highlight the panel and double click it, the users can configure the intrusion panel’s property. 



 60 

 

Figure 5-1-35 

5.1.9 Search Intrusion Panel 

Refer to section 5.1.8. 

5.1.10 Intrusion Panel Components 

Click the Intrusion Panel Components sub-menu item on the Setup/Hardware menu will open the 

Intrusion Panel Components screen. 

 

Figure 5-1-36 
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5.1.11 DVR Configuration 

Before proceeding with the DVR configuration within the Secusys software, the DVR itself needs to 

be configured as follows: 

1. Connect the DVR to the same network as the Secusys PC. 

2. Power up the DVR. 

3. Connect at least 1 camera. 

4. Open up the DVR management screen, Login (for the Secusys Series 2 DVR’s login using 

“admin” as user name and “888888” as the password). 

5. Click “General” then “Network Setting” and set the IP address and the subnet mask. If it is to 

be routed through a gateway then enter the Default Gateway IP address otherwise leave it 

blank. 

6. The default Port that Secusys software uses for communication with the DVR is 8101. Check 

the port on the DVR and change this to 8101 if it is something different.  

7. Save the DVR settings. Note the confirmation message and also if there is an IP address 

conflict a message will appear. 

8. On the host PC, open the CMD prompt and PING the DVR’s IP address to make sure that it is 

responding. 

Once the DVR has been set up and replies to the PING message, go to the Setup Communication 

Configuration and make sure that the correct series of DVR is selected. 

Then click on the DVR Configuration sub-menu item on the Setup, Hardware menu to open the DVR 

Configuration screen. 

 

Figure 5-1-37 

Click Search to bring up the Search DVR screen Enter the IP address of the DVR in the left hand 
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panel or click local network. Make sure that the Port is the same as on the DVR. Enter the same user 

and password as in the DVR 

 

Figure 5-1-38 

Once the DVR has been found, click the check box next to the IP Address and click the “Save” 

button. The DVR will now be listed in the DVR screen. 

 

Figure 5-1-39 

At the bottom of the DVR list there are additional buttons. The edit button opens the Edit CCTV 

DVR screen where the DVR can be given a name. 
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Figure 5-1-41 

5.1.12 Search DVR 

Clicking on the Search DVR sub-menu item on the Setup, Hardware menu will open the Search 

DVR screen directly instead of going via the DVR List screen. Refer to section 5.1.11. 

5.1.13 DVR Channels 

Clicking on the DVR Channels sub-menu item on the Setup, Hardware menu will open the DVR 

Channels screen. If the DVR has been configured correctly, found and saved then the DVR will 

appear in the left hand panel and the DVR camera channels will appear in the right hand panel. 

 

Figure 5-1-42 

Clicking the refresh option will open the CCTV Camera Preview window. Clicking the View Page 

tab in the bottom right hand corner of the CCTV Preview screen will open the view page screen 

where the operator can select the layout of the screen that they require. 
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Figure 5-1-43 

5.1.14 Channels to Doors/Zones Mapping 

Clicking on the Channels to Doors/Zones Mapping sub-menu item on the Setup, Hardware menu 

will open the Channels to Doors/Zones Mapping screen. 

 

Figure 5-1-44 

Click on the “Add” button to bring up the Channel to Door Mapping screen. 
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Figure 5-1-45 

The entered data will now appear at the bottom of the main Channel to Doors Mapping screen and 

will also be listed in the main screen area. 

5.1.15 Fingerprint Reader 

Clicking on the Finger Print Reader sub-menu item on the Setup/Hardware menu will open the 

Finger Print Reader List screen. 

However before proceeding with this make sure that the Fingerprint Communication Parameters 

have been set up first. There are FPC1000, FPC2000, DPU3000W8 and so on. 

 

Figure 5-1-46 
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5.1.15.1 Parameters 

 

Figure 5-1-47 

Name：                  Fingerprint Device name 

Firmware Version：        Firmware Version  

Screen Saver：            No action time, Device turns to standby mode 

Background Picture:  Change the background in the fingerprint device, the format size is 320*240 

Verification Factor:         Fingerprint recognition mode, there are 5 modes to choose: 

“fingerprint”, “fingerprint/card”, “card+fingerprint”, 

“card+password” and “fingerprint + password” 

Multi-FP Detect:           FPC2000 fingerprint supports one person to enter multiple 

fingerprints to prevent the opening of the door due to a broken 

fingerprint. The default is “effective”. Note: A person can only 

support up to 3 fingerprints. 

Scan Timeout(S):          When enrolling, if fingerprint is not scanned or not scanned correctly, 
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the registration fails.  

1:N:                    Whether the fingerprint comparison in the fingerprint machine is 1:N 

When “Effective” is selected, the fingerprint comparison speed will 

be slower, but the recognition rate is higher. 

Working Mode:           In addition to being used as a fingerprint reader, FPC3000 can also be 

used as a fingerprint attendance machine. When the attendance 

machine is used, there are two modes to choose from: “fingerprint 

reader” and “fingerprint attendance machine”. 

Door sensor:             set the state of the door magnet in the fingerprint machine, which can 

be set to "normally open" and "normally closed". 

Lock open time:          set the action time of the fingerprint machine to unlock, up to 255 

seconds 

Super PIN:              It means that the super user only needs to input the max 8-digits super 

password to open the door. The super user can open the door in any 

state of the door, without swiping the card. Note: There is only one 

super password per door. 

Tamper Alarm:          When someone tamper the fingerprint machine, it will make sound "DI" 

alarm. 

Get Events:             Set whether the fingerprint machine uploads records to the computer 

Unit ID:                Device ID 

Menu Language:         language selection in the fingerprint machine, you can choose 

"Chinese" and "English" 

Auto Detect FP:         Set to “valid”. When the fingerprint machine detects a fingerprint, it will 

automatically read; set to “invalid”. When it is standby, you need to Press 

the ‘ENTER’ button to activate the fingerprint machine to read the 

fingerprint information. 
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Humidity FP Detect:    Detection mode for wet fingerprints 

1:1(Verify):           There are 9 options in it, which are selected according to the actual 

situation to improve the recognition rate of 1:1 fingerprint. 

1:N (Identify):         There are also 9 options, which are selected according to the actual 

situation to improve the recognition rate of 1:N fingerprint. 

Wiegand_Output Item:  Select “card number”, the Wiegand number of the fingerprint machine 

output is the card number; select “user ID”, the output Wiegand number 

is the personnel user id. 

Display Mode:        Set what appears on the screen display after the user presses the fingerprint 

or swipes the card. 

Lock Monitor Time:    Set the fingerprint machine open door alarm, door open too long  

Menu password:      Set the password to enter the fingerprint machine menu 

Network parameter:   Set the network IP mode of the fingerprint machine. When set to the 

“configurable” option, the IP address of the fingerprint machine can be 

changed; when set to the “protected” option, the IP of the fingerprint 

machine is indicated. The address cannot be modified. When set to "forced 

IP", the IP address of the fingerprint machine is mandatory IP address. The 

mandatory IP address is 10.1.1.10. 

5.1.15.2 Status Schedule 

We can set the status of the fingerprint reader in the corresponding time period in【status 

schedule】, For details, please refer to section 5.1.4.2 
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Figure 5-1-48 

5.1.15.3 Door Access Schedule 

In this interface, we can edit the user authorization time group. For details, please refer to 

5.1.4.3. 

5.1.15.4 Finger User 

On the 【Fingerprint User】, you can see the users who have permission on the fingerprint 

machine. At the same time, you can also manually add users on this interface. 

 

Figure 5-1-49 
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The fingerprint device also include DPU3000W8, which is wireless fingerprint lock controller. In 

communication configuration interface, choose it, then add the SN and channel to manage it. 

 

Figure 5-1-50 

 

Figure 5-1-51 

 

5.1.16 Face Recognition 

There are NF1000 series-NF9000 series. 

First set in【communication configuration】, choose the face recognition device type . 
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Figure 5-1-48 

Then Clicking on the Face Recognition sub-menu item on the Setup,  

 

Figure 5-1-49 

Hardware menu will open the Face Recognition List screen. Face Recognition device can be added 

in the Secusys software.  
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Figure 5-1-50 

5.1.16.1 Search 

Search for the corresponding network segment face device, tick up the device, double-click to 

modify the IP, and save it. 

 

Figure 5-1-51 

5.1.16.2 Add 

Add the device manually. 
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5.1.16.3 Delete 

Delete the device.  

5.1.14.3Download configuration  

After enroll the face, also set the parameters, it can download configuration automatically。 

Double click the device to configure the device.  

 

Figure 5-1-51 

Basic Information:      Device name, serial number, record； 

System Parameters:     Recognition Parameters, TTS, Stranger Parameters, Output Parameters 
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Figure 5-1-52 

Recognition Mode：      Card Mode, Face Mode, Card + Face Mode, Identity Card + Face.  

 

Figure 5-1-53 

Display Setting：      Set Logo, Time Zone 
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Figure 5-1-54 

Network Setting： 

 

Figure 5-1-55 

Face User：     Display the enrolling face User. 
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5.1.17 LED Screen 

Clicking on the LED Screen sub-menu item on the Setup/Hardware menu will open the LED screen 

window. This screen is used to set up an external, serial or TCP/IP connected LED display screen. 

Click the “Add” button to add a LED screen. 

 

Figure 5-1-56 

Complete and save the required parameters. 

 

 

Figure 5-1-57 

5.2 Cards 

Clicking on the Setup, Card menu item will bring up the Card menu. 



 77 

 

Figure 5-2-1 

5.2.1 Access Security Groups 

Clicking on the Access Security Groups sub-menu item on the Setup, Card menu will open the 

Personnel screen window. 

 

Figure 5-2-2 

The screen shows that the controller’s Access Rights, including the entry door and the exit door. We 

can see in the figure 5-2-2, the options can be set up are no entry, 24 hours time table, day time table, 

night time table and other 12 time tables the user need. 

5.2.2 Personnel List 

Clicking on the Personnel sub-menu item on the Setup, Card menu will open the Personnel screen 

window. The Personnel List is where the main user information is entered. All the individual 
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personnel information can be found in this screen. Personnel can be added, modified or deleted. 

From this screen Personnel records can also be exported as Excel, Text, Html or MS-Word file 

formats. 

Clicking on the Personnel sub-menu item on the Setup, Card menu will open the Personnel screen 

window. 

 

Figure 5-2-3 

5.2.2.1 Adding a Person 

To add a person, click File/Add or click on the Add a Person icon. Adding a person will bring up the 

Personal Information screen which consists of 5 tabs, Basic Information, Card, Access Level, 

Fingerprint and Face Info. From within these 5 tabs, all employee information can be set up. 

➢ Basic Information 

Complete the information required for the basic information including a photo then move to the next 

tab. 

 

Figure 5-2-4 
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➢ Card 

If the user has an access card, then tick the “Use Access Card” box. Not all users will have access 

cards, for example a Time & Attendance user may or may not have an access card. Allocate the user 

a card by either clicking on the card list and selecting a previously added card, or, tick one or two of 

the Retrieve Card Number boxes then badge the card on either a desktop or system reader. The card 

number will appear. 

  

Figure 5-2-5 

➢ Access Level 

The Access Level tab allows the access level for this particular person to be set up. Note that the 

Access Level Time Tables of each door are defined.  

 

Figure 5-2-6 



 80 

 

Figure 5-2-7 

➢ Fingerprint 

The Fingerprint tab allows the Fingerprint access level for this particular person to be set up Lift 

Access levels are set up the same as normal access levels. 

 

Figure 5-2-8 

➢ Face Info 

The Face Info tab allows the face access level for this particular person to be set up. 
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Figure 5-2-9 

5.2.2.2 Editing a Person 

Personnel can be edited. Highlight the user then click on the “Edit” button. The same screens as 

Section 5.2.1 apply. 

5.2.2.3 Deleting a Person 

Personnel can be deleted. Highlight the user then click on the “Delete” button. Click “Yes” when 

asked if you want to delete this user. The user will then disappear from the Personnel List. 

 

Figure 5-2-10 

5.2.3 Access Level 

Clicking on the Access Level sub-menu item on the Setup, Card menu will open the Access Level 

screen window. This interface is used to allocate to individual personnel Time Tables for doors and 

also copy a person’s access levels to another person. 



 82 

 

Figure 5-2-11 

To copy a personnel’s access levels from one person to another, first highlight the person whose 

access levels you wish to copy and click on the “Copy” button. The person who you are copying 

from will turn green. 

 

Figure 5-2-12 

Then highlight the Person that you wish to copy the access levels to and click on the “Paste” button. 

To continue copying to other personnel continue to highlight the other persons and click “Paste”. A 

confirmatory box will appear, click “Yes” to continue. 

 

Figure 5-2-13 

5.2.4 Pre-set Access Level 

Clicking on the Preset Access Level sub-menu item on the Setup menu will open a screen showing 

different types of Events where the required option can be selected. 
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Figure 5-2-14 

Highlight the person you want to preset the access level, click “add”. Input the access level group, 

start time, end time, and click OK, then the access level has been preset successfully. 

 

Figure 5-2-15 

5.2.5 Emergency Cards 

Clicking on the Emergency Cards sub-menu item on the Setup menu will open a menu showing the 

Emergency Cards have been added in the Secusys 3.2 software. 

 

Figure 5-2-16 

Click “add” to increase an Emergency Card, input the card number in the blank, then click OK to add 
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a card. 

 

Figure 5-2-17 

 

Figure 5-2-18 

5.2.6 Bank Card 

 

Figure 5-2-19 
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First add the bank 

 

Figure 5-2-20 

Add bank card type 

 

Figure 5-2-21 

Add card code, different banks have standard bank code.  

 

Figure 5-2-21 

5.3 Event Alerts 

Clicking on the Event Alerts sub-menu item on the Setup menu will open a smaller sub menu 

showing different types of Events where the required option can be selected. Secusys3.2 software 

provides powerful and flexible event handling and notification. There are 6 screens, one for Access 

Events, 4 for Intruder Alarm Events and one for CCTV Events. As these screens are essentially 

identical and duplicate the information, the example and explanation below apply to all screens 

although the Access Events screen is used. 
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Figure 5-3-1 

For each type of event the user can assign a name, validation (by card number range, date and time), 

back ground color, the event color (in the “Events Monitor), sound file, pop up window, map and 

other information. 

 

Figure 5-3-2 

The explanation of this screen is as follows: 

Name:  A name the user can give to the Event. 

Event: The Event as defined in Secusys system. 

From Card No: The Alert handling will apply for card numbers equal or higher than 

this.00000000 is the default and most commonly used. 

To Card No: The Alert handling will apply for card numbers equal or lower than this. 

4294967295 is the default and most commonly used. 

From Date: Starting date to apply to the event handling. 

To Date: Ending date to apply to the event handling. 

From Time: Starting time to apply to the event handling. 

To Time: Ending time to apply to the event handling. 
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Color: Selecting a background color for the event to be shown in the “Events 

Monitor”. 

Sound File: Wave file to be played when the event happens. 

Pop Up: Enabling and positioning an “MSN Messenger” style Popup window which 

will summarize the event info. 

Keep Arming: Arming lasted for a span. 

Popup Icon: the type of icon (if any) to be presented inside the Popup window. Type of 

Icons are: Confirmation / Warning / Error / None. 

Map Pop Up: If checked the events’ corresponding map will pop up. 

The following event colors can also be set up: 

Default Font Color, Default Background Color, Acknowledged Font Color, Acknowledged 

Background Color, Normal Font Color and Normal Background Color 

Buttons and Commands (figure 5-3-3): 

 

Figure 5-3-3 

Speech Setup: Set up a speech file for an event and test (figure 5-3-4). 

New Alert: Creating a new alert handler. 

Delete Record: Deleting an alert handler. 

Edit Event Alert: Editing the handler. 

Clicking on the Speech Setup icon opens up the Speech Setup window. Here the Speech Engine 

required can be selected from the dropdown menu and a test made. 

5.4 Map 

Clicking on the Map sub-menu item on the Setup menu will open a smaller sub menu showing 

different types of map functions. Secusys provides comprehensive graphical monitoring and control. 

The Map allows visual maps of the different sites, building and floors. A user can view all controller 

components on a map (locks, sensors, exit buttons, inputs, and outputs). All maps and controller 

components are dynamic. Components will change their graphical icon if their physical status has 

changed (i.e. the lock was unlocked or the door was opened). Maps can be easily designed by placing 

controllers’ components on and even changing icons or adding icons to components. Maps can also 
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Popup, refer section 5.3. Secusys will automatically switch from Map X to Map Y if an alert event 

takes place on a Maps’ Y controller component. 

 

Figure 5-4-1 

5.4.1 Multi Site Setup 

Multi Site Setup is setting the entire company structure where the sites and their names, the buildings 

in each site, the floors in each building and their maps are defined. Set up a site(s), building(s) and 

floor(s) then click on the “New Map” button at the bottom of the screen to open the Map Designer 

window. 

 

Figure 5-4-2 

Any controllers that have been added to the system will appear in the lefthand panel. If a RED cross 

appears then that particular controller is not currently online. In the example below the controllers 

have been renamed to their particular areas, this helps when using tenancies. Renaming is done after 

a controller has been added and saved, however if for any reason controllers are searched and saved 

again, then the default controller name will over write the entered name. 

 

Figure 5-4-3 

The Map Designer window has the following buttons: 
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New: A blank canvas for creating a new map. 

Save: Saving the created map. 

Save As: Saving the created map under a different name and “Pic ID” (Picture ID). 

“Pic ID” is the unique identifier for maps. User can re use the map name but 

not the “Pic ID” of the map. 

Rename: Changing the map name. 

Load: Loading a JPG picture to be the map usually a floor or blue print drawing. 

Remove: Removing the map JPG file. 

Add: Adding controller components on the map. Multiple components can be 

selected by holding down the “Shift” Key and clicking on “Down Arrow” or 

by holding “Ctrl” key and selecting multiple components using the mouse. 

After adding the components, they will show up on the left upper corner of 

the map (overlapping each other). Each one can be dragged to the desired 

position then click “Save” to keep them in the new position. 

Properties:         Select the item in the map, show the properties screen. 

Delete: Select a component and click “Delete” to delete it from the map.  

Close: Close the Map Designer window. 

If a map is to be saved then save the blank canvas as a map. 

 

Figure 5-4-5 

5.4.2 Map Designer 

This is used to design or edit an existing map. Click on the Setup, Map, Design Map sub menu item 

and the Design Map screen will appear. Note that a map canvas must have been set up and saved 

under the previous section and any map canvas that has been setup previously will appear in the list. 

Double click on the map canvas or highlight then click on the “Design Map” button. 
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Figure 5-4-6 

The icons and menu items are explained in the previous section. Click on the “Load” button to load a 

background floor plan or graphic. To add a component click on the “Add” button then drag the 

component required from the left hand access tree onto the map. 

5.4.3 Delete Map 

Delete a Map by selecting it from the list and clicking the “Delete” button. 

5.4.4 Icon Library 

Secusys provides a default icon library which can be used for the different controller components. 

The library offers a selection of different icons for the same component including different size (i.e. 

small lock icon, big lock icons etc.). This provides high flexibility for the user in respect to the map 

picture or blue print proportion. 
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Figure 5-4-7 

Add: Add an Icon by selecting a JPG picture, entering an Icon ID and Icon name. 

Delete: Delete an Icon. 

Rename: Change an Icons’ name. 

Change Icon: Change the Icon picture (JPG file). 

5.5 Flow Control 

Clicking on the Flow Control sub-menu item on the Setup menu will enable either the Access Flow 

Control or the Intrusion Flow Control menu options to be selected. 

 

Figure 5-5-1 

5.5.1 Flow Control By Inputs 

For the following sections the Access Flow Control has been selected as this is the most common. 

The Intrusion Flow Control is almost identical in the setup however an intruder alarm panel must 

have been added previously. 

The Flow Control allows the user to define the logical conditioning of: 

IF (Condition) THEN Action (XXX); AND & OR functions can be applied to allow for more 

complex conditions. There are 4 types Flow Control: By Inputs, By Events, Code Driver, Global 

Flow Control (Software). 
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Figure 5-5-2 

Flow Control by Inputs means the Flow Control is processed according to the physical controller 

components of Locks, Exit Buttons, Door Sensors, Aux Inputs/Outputs etc. A condition can be 

created: 

IF (Source1) AND (Source2) AND … (Source8) THEN Activate (Relay); 

Several “Sources” do not have to be used with “AND” Secusys Flow Control allows the user to use 

the Secusys system not only for an Access Control application but also for any type of automated 

control like Building Management. For a Fire Alarm all doors can be commanded to unlock 

automatically. Based on an external timer or sensor, lights or air conditioning systems can be turned 

on or off in the building. 

To create a Flow Control by Inputs, click “Add”. The Add Condition window in will appear. 

 

Figure 5-5-3 

 

5.5.2 Flow Control By Events 

Similar to “By Inputs” Flow Control, “By Events” allows to create conditions based on the software 

events. Secusys is generating events in respect to each one of the doors. We are able to activate 

different outputs based on the different events. The events are those described in Section 5.3, “Events 

Alerts” (e.g invalid card, invalid time/door, door unusual open etc.). 

An “Invalid Card” flashing event can be programmed to activate one of the outputs to turn on a siren, 

lights, or any other application. 

Delay Time from the time the 

condition is TRUE till the time the 

Output Action will take place 

Keep the activation of the Output 

relay even after the source condition 

is no longer TRUE. 

Once the condition is not TRUE, 

the Output Action will stop. 

Priority of this Flow Control 

condition compared to others. 
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The condition structure will be: IF (Event 1) OR (Event 2) OR…(Event 11) THEN Activate (Relay) 

for T seconds; Event 1 to Event 11 are always in respect to the same door. In Flow Control By Events 

there is no “AND” since at a given moment only 1 event can take place in a given door. Secusys can 

handle up to 11 different events conditions per door. 

Click the “Edit” button at the bottom of the Flow Control screen to open the “By Events Conditions 

(OR) window. Clicking on the arrow to the right of the event and select an event(s) then select an 

action. Then you can see the control on the Flow Control screen. 

 

Figure 5-5-4 

 

Figure 5-5-5 

5.5.3 Global Flow Control (Software) 

Global Flow Control is where a condition can be created which is based on a source in one controller 

and the action will take place in another controller. For this to happen the Secusys software must be 

running and online to all controllers. In the below example the Secusys MD and GM door controller 



 94 

is actually off line. So even though the Secusys server is running, any conditions or actions 

associated with this controller will not work. 

 

Figure 5-5-6 

Click on the “New” button to set up a new condition. IF (Aux Input1 of the SECUSYS main Entry 

Door Controller is opened for more than 5 seconds) THEN Open (Aux Output 2 of the Secusys Misc 

Doors Controller) for 10 seconds. 

 

Figure 5-5-7 

5.6 Wiegand Format 

Clicking on the Wiegand Format sub menu item on the Setup men will open the Wiegand Format 

screen. The method by which Secusys controllers can be configured to read multiple formats 

simultaneously is set up from this screen. The system comes as default with the two most common 

Should be Enabled 

 

Keep the activation of the Output 

relay even after the source 

condition is no longer TRUE.  

 

The Time Limit for the Output 

to remain Open after the 

condition is no longer TRUE. 

 

Delay Time from the time the 

condition is TRUE till the time 

the Output Action will take place  

Priority of this Flow Control 

condition compared to others. 
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formats pre defined. These are 26 bit and 34 bit. Any format between 24 and 72 bit can be configured 

from this screen. If the system is required to read a card with a number of bits outside the two listed 

above, then these formats need to be configured before a card will be able to be read by the system. 

 

Figure 5-6-1 

To edit a format, highlight the format and click on the “Edit” button. The Wiegand Format setup 

screen will appear. The “Use Wiegand XX Bits Format” box must be ticked if you wish the system to 

recognize this format. 

 

Figure 5-6-2 

The example is a for 34 Bits format. There are a total of 34 bits. The 1st (bit 0) and the last (Bit 33) 

are parity bits so these are not counted as cardholder data so have a 0 instead of a 1. The 32 bits in 

the middle (from bit 1 to bit 32) are data bits and need to be counted so these need to have a 1. The 2 
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parity bits have different functions. The 1st one, Parity No I is located at Bit 0 and is calculated as 

odd parity using bits 1 to 16 for its calculation. The 2nd one, Parity Bit no 2, is located at bit 33 and is 

calculated as even parity using bits 17 to 32. Note that this is a very simple example with the parity 

being at the start and the end of the format. But beware that not all card formats are like this. 

When setting up a data format initially leave the two “Parity” boxes blank and proceed to the “Data 

Format” panel at the bottom of the screen. At the Data Format panel, enter the valid bits you want 

read as a “1” and any bits that you do not want to be read enter as a “0”. If you only know the 

number of bits on a card but do not know where the parity bits are located then as a temporary 

measure enable all the card bits, i.e. for 34 bits, place a “1” under bits 0 to 33. At this stage close the 

screen and flash a card conforming to the format that has been entered. If the card reads and creates a 

card event in the “Events Monitor” then the system is recognizing the card format. Note at this stage, 

this is not the card number, it is just the number generated by all of the bits that have a “1” allocated 

to them. 

Return to the Wiegand Format screen to continue. If nothing happens when a card is flashed and the 

system does not recognize the card format at this stage then the card is not the same format that has 

been edited. 

Now that the system is actually reading the card format. The next step is to set the Data Format box 

so that the system ignores any Parity bits for the purpose of calculating the card number. The most 

common formats, but not all, have a Parity bit at the start of the card data and another at the end. 

While these bits appear on the card and form part of the bit structure and number of bits, they do not 

contribute to the card number. The Data Format box now needs to be edited and a “0” placed under 

any bits that are Parity bits. In the example, the 1st (bit 0) and the last (bit 33) are both Parity bits so 

a “0” is placed under bits 0 and 33. Click “OK” then flash the card at a valid reader. The number that 

appears now is the card number. In the example, the standard MIFARE 34 bit card has been used. 

The standard MIFARE card has 32 cardholder bits plus 2 x parity bits, one at each end, giving a total 

of 34 bits. Note that some readers, for example, add one byte checksum (8 bits) onto the MIFARE 

card number and send the data out as 40 bits. 

The “Next” step is to enter the Parity data into the Parity 1 and Parity 2 screens. Although the system 

will work without this information, parity bits protect the data being received by the system and 

ensure that only valid data is received. In the 34 bits example, the parity bits are bit 0 for parity bit 1 

and bit 33 for parity bit 2. Enter a “0” for Parity No 1 and enter a “33” for Parity No 2. If there are 

more than 2 parity bits then ignore them. 
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Parity can be either None, Odd or Even and this must be known. Parity Bits check that the data is not 

corrupted and will normally be calculated over a specific number of bits. In the 34 bits example, 

Parity No 1 (Bit 0) is Odd Parity calculated over bits 1-16. Parity No 2 (Bit 33) is Even Parity 

calculated over bits 17-32. The card manufacturer will normally supply the total number of bits, the 

location of parity, whether parity is None, Odd or Even and the bits over which the parity is 

calculated. 

Note that there are many different methods for numbering the bits. The Secusys software and 

controllers count from the righthand side at bit 0. Some systems start counting at bit 1. No one 

system is more correct than another. 

5.7 Special Date 

Clicking on the Special Date sub-menu item on the Setup menu will allow the operator to select 

either a Temporary Date or Holidays. 

 

Figure 5-7-1 

5.7.1 Temporary Date Setup 

Clicking on the Temporary Date sub-menu item will open the Temporary Date Setup screen. Two 

sets of Temporary Dates can be set up. The default date is the current date. Temporary dates will be 

canceled after 7 days. 

 

Figure 5-7-2 

5.7.2 Holiday 

Clicking on the Holiday Setup sub-menu item will open the Holiday Setup screen . To select a 

holiday, double click on the date and the color will turn Red to indicate that this date is now a holiday. 

To cancel a previously selected holiday, double click the red holiday and it will return to the default 
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color. There are seven holiday groups available from the tabs at the bottom of the screen; each group 

can have 365 holidays. 

Note that currently the software only allows for holidays to be set up for the current year. However 

after a request Secusys is currently looking at ways to allow this year to either be increased to 

include “this year” and “next year”, or allow for a rolling 12 month period. 

 

Figure 5-7-3 

5.8 Communication Configuration 

Clicking on the Communication Configuration sub-menu item on the Setup menu will open the 

Communication Configuration screen. In order for the software to communicate with devices, the 

communication parameters need to be set up. There are 10 different tabs as follows: 

1. Server 

2. Communication 

3. Clock Adjustment 

4. Desktop reader && Card 

5. DVR 

6. Intrusion 

7. Fingerprint 

8. Face Recognition 

9. Times Canteen 

10.Metting 

11.Send Events Packets 

        12.Bank Card 

        13.SMS Notification 

        14.Send Operation Logs   
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Figure 5-8-1 

5.8.1 Server 

The Server name or IP Address is the name or IP address of the PC which runs the 

Secusys 3.2 Server software. If there is only one PC running the Secusys software 

then that PC is the Server. The Server Port is 47110 by default and there is no need to 

change this unless other software is running on the same PC and is using this port 

(highly unlikely but not impossible). The check database only needs to be checked if 

the database is located on a different machine, for example if an SQL server PC is 

being used. If checked the software checks to see that this SQL Server PC is actually 

powered up and on line and that there are no network issues to prevent the Secusys 

software from communicating with the database. 

5.8.2 Communication 

5.8.2.1 Network Delay Time: 

This is the maximum delay time allowed between the controller and the Host PC. In 

this example if the delay will be more than 50 milliseconds, Secusys will consider the 

controller Offline. In some slow networks this value may need to be increased from 

50 to 200. If controllers are connected over a WAN the delay can be even up to 

10,000 Milliseconds. The user can adjust the value according the quality of the LAN 

in use. As a guide, if controllers are connected by unstable LAN, the Delay Time 
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should be more than 50 Milliseconds, e.g. “200” Milliseconds. If controllers are 

connected through Wireless LAN, the Delay Time should be more than 50 

Milliseconds, e.g. “200” Milliseconds. If controllers are connected over a WAN, the 

Delay Time should be more than 50 Milliseconds, e.g. “1,000” Milliseconds. 

5.8.2.2 Get transaction one by one: 

If the check box is ticked, Secusys will receive the transactions (events) from each 

controller one at a time. Secusys will upload all transactions of controller number 1, 

then it will collect all transactions from controller number 2, then number 3 and so on. 

Otherwise, Secusys will upload 256 transactions from controller number 1, then 256 

transactions from controller number 2, then 256 transactions from controller number 3 

and so on. 

5.8.2.3 Record communication log: 

If ticked all the communication events will log in the “Communication.txt.” log file. 

The file is in the Secusys folder. The log enables Secusys engineers to analyze the 

status of communication with the controllers. An installer may be requested to tick 

this box should LAN troubleshooting be required. 

5.8.2.4 Broadcast public information: 

If ticked the public information (All the information which is common to all 

controllers e.g. Cards information, Holidays, Summer/Winter time etc.) will be sent to 

all controllers at the same time. The public information will be sent only one time. If 

there is communication/network failure, some information might be lost and not reach 

the controllers. The advantage is time saving in sending the information in case of 

large number of controllers. If the check box is not ticked, Secusys will send the 

public information to the controllers one by one. If communication fails, it will send 

again automatically up to 10 times. It is recommended not to tick the check box. 

5.8.2.5 Area will be changed by valid event (without sensor, PC should be on line): 

This function is used if the user would like to use the Anti Pass Back (APB) function 

when there are no door sensors connected. The APB function by default is changing 

the persons area based on a “Valid Card” event + Door Sensor Opened. This means 

the door was pushed and opened and the most likely scenario is the person then 

entered through the door and changes areas. If the user ticks this option the area will 

change based on a “Valid Card” event only. However increase the chances for failure 

as just a card badge will change the personas area. For APB the Secusys software 

needs to be online. 
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5.8.2.6 Host IP Address: 

Clicking  will give the IP address of the PC which is connected to the TCP/IP 

controllers. 

5.8.2.7 Listening Port: 

The PC port is that is used for the TCP/IP communication. The default is 8000. 

After setting the communication parameters, click on “OK” to apply the new settings. 

 

Figure 5-8-2 

5.8.3 Clock Adjustment 

At the Clock Adjustment tab, clicking the Clock Adjustment button allows the date 

and time to be set up. The software will then download the PC time to the access 

controllers, the DVR or the Fingerprint controller. 
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Figure 5-8-4 

5.8.4 Desktop Reader & Card 

In the Desktop Reader tab there are 5 dropdown menus for setting Desktop reader 

parameters. Different manufacturers may use different protocols for the RS-232 

connection to the desktop reader. The reader needs a file to read ID Card information. 

The desktop reader needs to be configured in order to have the same card number 

when adding a card with a desktop RS-232 reader or Wiegand system reader. This 

configuration is done via these two dropdown menus 
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Figure 5-8-5 

COM Port: Serial Port the desktop reader is connected. Don’t use the same COM 

Port as the controllers. 

Reader Type: The output type of desktop reader, 5588X-UH. 

Card Number Length:  Wiegand-26 or Wiegand-34: 

Identification Card Reader Port:  The physical port to which the desktop reader 

is connected to 

Card Number Format:  The display format of card number in Secusys. 

The choices are Decimal, Wiegand and HEX. 

QR code Reader:             include 485 and Wiegand QR code reader 

5.8.5 DVR 

Secusys has 10 series of DVR’s available that have been integrated with the Secusys 

software, these are known as Hikvision, HanBang, DaHua, WatchNET, Genie, TVT,  

WaveStore, Milestone, Milesight. The setup parameters are found in the DVR 

Communication Configuration tab. If any DVR’s other than these 10 series are 

required to be interfaced then this can be done but at a cost. 
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Figure 5-8-6 

5.8.6 Intrusion 

Secusys has 3 series of intrusion available that have been integrated with the Secusys 

software, these are known as Prosys, DSC, PIMA, ProSYS Plus, EL-Far. And the 

communication timeout and communication interval can be set up by changing the 

time. 

 

Figure 5-8-7 
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5.8.7 Fingerprint 

The Secusys software currently includes interface drivers for eight series of Secusys. 

Once the FingerPrint driver have been loaded as part of the installation process and 

the hardware key has been enabled then select the series required from this screen. 

There are FPC1000 , FPC2000, FPC3000 and DPU3000W8 series.  

 

Figure 5-8-8 

5.8.8 Face Recognition 

There are NF1000 and NF4000 series devices be used. 
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Figure 5-8-9 

5.8.9 Times Canteen 

The Secusys software has an option Time & Attendance module which is enabled by 

the hardware key providing it is installed. If it is not installed then the software 

installation file needs to be rerun and the Time & Attendance box ticked. If the Time 

& Attendance module is installed and licensed then the particulars can be set up here. 

 

Figure 5-8-10 
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5.8.10 Send Event Packets 

The Secusys software can send event messages to 3rd party software. Tick the “Send 

Event Packets …” message box, enter the Server name or IP address for the 3rd party 

server then enter the remainder of the details as required. 

 

Figure5-8-11 

5.8.11 Bank Card 
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5.8.12 SMS Notification 

This need set the Send Server first. You can set to send Email or SMS. 
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5.8.13 Send Operation Logs 

 

5.9 Area Name 

Clicking on the Area Name menu item on the Setup menu opens the Area Name 

screen. If Anti Passback or Time & Attendance is being used then area names may 
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require to be changed to accurately reflect the actual area. Click the “Edit” button to 

Edit an area. 

Check the options you need to relate exit area and entry area. 

 

Figure 5-9-1 

5.10 Saved Events 

Clicking on the Saved Events menu item on the Setup menu will give the user 5 

options, Access, Prosys, ProSYS Plus, DSC, PIMA and CCTV System Events. For the 

purposes of the following examples the Access Saved Events sub menu item is 

explained however these 6 are all identical in the setup, just the events change. 

 

Figure 5-10-1 

The Saved Events screen allows the user to select or deselect any events that are not 

required to be saved in the memory of the controller. By default, all events are saved 

but there may be occasions where certain events are not required to be saved. 
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Figure 5-10-2 

5.11 Car Parking 

Clicking on the Car Parking menu item on the Setup menu opens the Car Parking 

Settings screen. Car Parking control can be achieved in a parking building by 

counting the number of cars entering and leaving and limiting the maximum number 

when the car park is full. Once the car park is full, is the maximum number of cards 

has been reached an output will be activated. The output can turn on a red traffic light 

or Car park Full sign. This feature requires the Secusys software to be online. A Car 

Parking Counter can be displayed on the software that keeps a running total of the car 

parking information. 

 

Figure 5-11-1 
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Chapter 6 Monitor 

The Monitor menu is where the operator can set up the Secusys software with their 

own screen preferences. Each operator can customize the screen to exactly what they 

wish to display then save it under the Window, Save Desktop menu items. When the 

same operator logs on then their saved desktop will appear. The reason that this is 

done is because there is just so much information that can be viewed and different 

sites will have different requirements on what an operator needs to be able to see. All 

these menu does is to set up the screen to show what the operator requires to see. 

           

Figure 6-0-1                  figure 6-0-2 

 

Controller Manager 

When any of the 1st 3 trees are opened, then a small tab will appear to the left of the 

Windows. This is the Controller Manager. 

The Controller Manager allows direct control of a controller. Once a tree is opened 

and a particular device is highlighted, then by clicking the right mouse button another 

menu will appear. This menu depends upon the item selected and allows the operator 

to command the controller to undertake the particular task that that been selected. In 

the example to the left a door has been selected. In the example below an output has 

been selected. 
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Figure 6-0-3 

6.1 Access Tree 

Clicking on the Access Tree menu item will display the Access Tree. 

6.2 Intrusion Tree 

Clicking on the Intrusion Tree menu item will display the Intrusion Tree which is very 

similar to the Access Tree. 

6.3 CCTV Tree 

Clicking on the CCTV Tree menu item will display the CCTV Tree which is very 

similar to the Access Tree. 

6.4 Map Tree 

Clicking on the Map Tree menu item will display the Map Tree panel on the lefthand 

side of the screen and will show any maps that have previously been created under the 

Setup, map menu item (Figure 6-4-1). 

 

Figure 6-4-1 
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6.5 Map Page 

Clicking on the Map Page menu item will display the Map Page box to the right of the 

Map Tree panel and will show the master map that has previously been created under 

the Setup, map menu item. 

6.6 Events 

Clicking on the Events menu item will allow the user to select from 9 different types 

of events. 

 

Figure 6-6-1 

The user can monitor all of these different types of events concurrently. Click on each 

of the events once to add them to the task bar at the bottom of the Events Screen. 

 

Figure 6-6-2 

All these events are self-explanatory and apply to the respective category selected. 

The Area Changed events are created only if Anti-Passback is activated. Double 

clicking on an event will open the relevant “Personnel Information” as described. It 

allows the user to change the information or even enroll a new card and person to the 

Secusys software (if the user has the privileges). Highlight an event then right clicking 

on the event will allow us to select which fields/events to view or to view the captured 
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image. It also allow the operator to tick the box called “Personal Photo Viewer” The 

Personal Photo Viewer is a box that is located on the right hand side of the screen and 

contains the basic information for an employee and their photo. 

 

Figure 6-6-3 

6.7 Photo Viewer 

The Personal Photo Viewer provides a fixed window where the details of the person 

who just flashed their card are listed. These details include the persons photo on file, 

their name, department, the card number and the controller and door where the card 

was presented. 

 

Figure 6-7-1 

In additional a small MSN Messenger style popup window will appear giving 
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basically the same information but this will only appear for 3 seconds while as the 

Personal Photo Viewer main window is fixed and remains as part of the screen setup 

if selected. 

 

 

Figure 6-7-2 

Clicking the 2 Photo Viewer A menu option will open the 2 Photo Viewer 

Screen(Figure 6-7-3), clicking the 4 Photo Viewer A menu option will open the 4 

Photo Viewer A screen(figure 6-7-4), clicking the 4 Photo Viewer B menu option will 

open the 4 Photo Viewer B screen(figure 6-7-5). 

 

Figure 6-7-3 
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Figure 6-7-4 

 

Figure 6-7-5 

6.8 Camera1 

Clicking the Camera1 menu option will open the Camera1 screen. 

 

Figure 6-8-1 

6.9 Camera2 

Refer section 6.8, Camera1. 

6.10 Park Counter 

Clicking the Parking Counter menu option will open the Car Parking Counter window. 

If car parking has been set up then car parking information will appear here. 
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Figure 6-10-1 

6.11 Camera View 

Clicking the Camera Preview menu option will open the Camera Preview window. 

Clicking the View Page tab in the bottom righthand corner of the CCTV Preview 

screen will open the view page screen where the operator can select the layout of the 

screen that they require. 

 

Figure 6-11-1 

6.12 Clients 

The Monitor Clients screen allows the operator to view any clients that are currently 

connected to the Secusys Database Secusys2000. 

 

Figure 6-12-1 
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Chapter 7 Report 

 

The Report menu allow the operator to select from a wide variety of reports and to 

customize reports (Figure 7-1). 

 

Figure 7-0-1 

7.1 All Card Events 

Generate a report with all the card events. All card events include by default Invalid 

Card events. 

 

Figure 7-1-1 
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The File menu has two options. The 1st is Delete Record. This is very powerful and 

can delete all the Card Records if done incorrectly. Only the administrator should 

have this function. The 2nd option in the File menu is “View Captured”. Highlight a 

particular access event then click this menu item. The File/Preview Play window will 

appear. 

 

Figure 7-1-2 

The View menu has a few more options. Here a Filter can be used to search for certain 

records and once found the export the report to an MS-Excel file. The report can be 

viewed in a Preview mode so it will be suitable for printing. 

Clicking on the Filter in View menu brings up the Filter screen. To search for records, 

click on the field you want to search for, enter a starting date and an ending date then 

click OK. Any records that exist conforming with your search criteria will be listed. 

     

    Figure 7-1-3                      Figure 7-1-4 

Records can also be searched by value by clicking on the By Value tab. 
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Figure 7-1-5 

A record can also be searched for a particular value. Click on Locate in View menu 

and the Locate Screen appears. Clicking on the dropdown box under the Fields label 

will list the fields on which a search can be made. Enter your data, tick any required 

boxes then click “First” to find the 1st entry conforming to the data then “Next” to find 

any subsequent matches. 

 

Figure 7-1-6 

7.2 Quick Query Cards Events 

A record can also be searched for quick query. It can be searched by department or the 

door of the controllers. Some other operations refer to section 7.1. 
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Figure7-2-1 

7.3 Cards Events Filter 

Different queries can be run to get specific event records regarding different personnel, 

departments, doors, or events. Once the query has been run it can be viewed, printed 

or exported. In the example below event records are required for Dave Adams for the 

date range specified and for all doors and all events. Clicking OK will result in the 

Query Result screen being shown. 

 

Figure 7-3-1 
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Figure 7-3-2 

Clicking on the View menu from the Query result screen brings up the View menu. 

This menu allows for the following: 

View Fields:  Fields can be setup. 

Refresh Data: Refreshes the query screen data. 

Filter: Brings up the Filter Search screen, refer to section 7.1. 

Cancel Filter: Cancels the filter. 

Locate Value: Brings up the Locate value screen, refer to section 7.1. 

Page Setup: Allows the font to be selected and margins set. 

Preview: Previews the print screen of the run query. 

Print: Prints the query screen. 

Export to a File: Exports the query in multiple file formats. 

Close: Closes this menu 
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Figure 7-3-3 

7.4 All Hardware Events 

This shows all the hardware events and is similar in operation to the Card Events, 

section 7-1. Hardware Events can be filtered, previewed, printed and exported as per 

the previous section. 

7.5 Area Report 

If Time & Attendance or Anti-Passback is being used then the operator may need to 

know how many staff are in each of the areas. The Area Report provides us with this 

kind of information. It has the same features in its View menu like previous reports 

covered in sections 7-1 to 7-4. Note that for the area counting to work, either the 

doors sensor must operate, or, in the Setup, Communication Configuration, 

Communication Tab box for processing an event with no sensor operation needs to be 

checked. In additional card readers need to be set up as Entry/Exit readers and areas 

allocated, see Setup, Hardware, Door Configuration. 

 

Figure 7-5-1 

7.6 Personnel Area Report 

Personnel Area Report allows us to see the Personnel currently in each area. It has the 

same features in its View menu as the reports covered in sections 7.1 to 7.4. Both this 

report and the Area Report can be used in emergency cases where security would like 

to evacuate the building immediately. In this way they can know where each 

employee is and know which areas are occupied or empty. In the below example there 

are currently 9 people in the Reception Area. 
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Figure 7-6-1 

7.7 Area Changed Report 

The Area Changed Report tracks how employees are moving inside the 

buildings/offices from one area to the other. This can help us to trace a certain person, 

see where he was and when, in case we need to investigate. One of the cases this 

report is used, is to know who caused damage to equipment of the office etc. It has the 

same features in its View menu like the reports described in Sections 7.5 to 7.6. Anti 

Passback must be activated and properly used. 

7.8 Access Level Report 

The Access Level Report lists all the card users and their respective access levels for 

every door on the system. It can be quite long, however the View menu allows us to 

filter as per previous sections of this menu. 

 

Figure 7-8-1 
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7.9 Times Canteen Report 

Clicking on the Times Canteen Report sub menu and brings up all kinds of report. 

This menu allows for the following: 

 

Figure 7-9-1 

The list shows varieties of reports for the Secusys system. 

7.10 All Intrusion Events 

The “All Intrusion Events” lists all the intrusion events and invalid access levels for 

every door on the system. It can be quite long, however the View menu allows us to 

filter as per previous sections of this menu. 

 

Figure 7-10-1 

7.11 All Intrusion Systems Status 

The “All Intrusion System Status” lists all the intrusion system status for every door 

on the system. It can be quite long, however the View menu allows us to filter as per 

previous sections of this menu 
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Figure 7-11-1 

7.12 All CCTV Events 

The “All CCTV Events” lists all the CCTV Events for the intrusion of every door on 

the system. It can be quite long. 

 

Figure 7-12-1 

7.13 All Alert Events 

The “All Alert Events” lists all the Alert Events for every DVR on the system. It can 

be quite long. 

 

Figure 7-13-1 
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7.14 Alerts Events Filter 

The “All Alert Filter” lists all the Alert Events for every DVR on the system. Set up 

the time, events, record type, and system, then click OK to save the settings. 

 

Figure 7-14-1 

7.15 System Log 

The System Log shows us which Secusys operator was logged on and when. It also 

shows us what kind of actions the operator took. This audit trail is essential if an 

investigation into an event takes place. The System Log has the same features in the 

View menu like the previous reports covered in sections 7.1 to 7.4. 

 

Figure 7-15-1 
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Chapter 8 Maintenance 

The maintenance menu allows an installer to setup the database for the system. There 

are many items in the maintenance menu list. 

 

Figure 8-0-1 

8.1 Delete Record 

The Delete Record sub menu item brings up the “Delete Events from Database” 

screen. This screen gives the user the option to delete one of more types of events 

simply by ticking the required box. Tick the type of event to be deleted then select a 

date to delete the records up to, or keep the last so many records, or delete all records 

then click “OK”. 

 

Figure 8-1-1 

8.2 Backup Database 

The user should backup the Database after any programming or personnel changes so 
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that the data can be restored if required. Select “Backup Database” from the 

Maintenance menu. Enter a backup file name then click “Backup”. Once backed up 

successfully the backup successfully message will appear. 

 

Figure 8-2-1 

8.3 Auto Backup Database 

The Auto Backup Database option allows the user to set a time and day for the 

database backup and this will then be done automatically. The backup frequency 

options: never, daily, weekly, monthly. 

     

Figure 8-3-1                   Figure 8-3-2 

8.4 Restore Database 

If the Database needs to be restored select “Restore Database” from the Maintenance 

menu. The restore needs full access to the database and if some other programs are 

using the database, the “Database Restore” option may not work. Disconnect any 

clients that may be using the database before restoring. Select the database that you 

wish to restore, and click OK. 
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Figure 8-4-1 

 

Figure 8-4-2 

Click OK to continue restoring the database, and when the database restored 

successfully, the Secusys software will restart. 

 

8.5 Compact/Repair Database 

The Compact/Repair Database is used to reduce the size of the database and to correct 

any errors. This is like compressing the database to save space and make it more 

efficient. It is highly recommended to perform the Compact/Repair Database at least 

once a month. Note that any clients need to be disconnected from the server before 

this can proceed. 
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Figure 8-5-1 

Once finished the Database repaired successfully screen will appear. 

8.6 Auto Compact/Repair Database 

The user can schedule an Automatic Compact/Repair to the Database instead of 

undertaking it manually as per the previous section. Select the Frequency from the 

dropdown menu, set a Day and Time then click “OK”. 

 

Figure 8-6-1 
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Chapter 9 Tools 

The tools menu allows an installer to setup many quick tools for the users. Here are 

many items in the Tools menu list. 

 

Figure 9-0-1 

9.1 External Tools 

Clicking on the Tools, External Tools sub menu item will bring up the External Tools 

window. “External Tools” are effectively shortcuts to existing programs like DVR or 

CCTV for instance that are required to be opened from within the Secusys software. 

 

Figure 9-1-1 

9.2 Import from Excel 

Secusys software allows the user to import data from an Excel file. The data can be 

taken from a 3rd party application like T&A software, Human Resources software or 

any other similar list of data. 

The data fields which can be imported are Personnel ID, First Name, Last Name, 
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Identity, Gender, Card Number and Departments. Before you proceed with importing, 

it’s highly recommended to back up the current Secusys2000 Database. Clicking on 

the Tools, import from Excel sub menu item will bring up the Import Wizard. 

 

Figure 9-2-1 

 

Figure 9-2-2 

Read the following comments carefully. Inside the Secusys folder there is a folder 

named “Template”, inside the Template folder there is a MS-Excel Template file 

called Personnel.xlt. Using Windows Explorer navigate to this file and open it with 

Microsoft Excel. Complete the information that is required to be imported into 

Secusys and save the file as an Excel 97-2003 Workbook (not shown). Once saved 

then click on the folder button, locate the file and select it. Clicking Next and the 

Import Screen will appear. 

9.3 Export Events Automatically 

Secusys software provides a powerful module which can be run separately to export 

all card events. This is purchased separately and is licensed and controlled by the 
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hardware key. The exporting is needed mainly for 3rd party software like building 

management or T&A which would need to have the access control events. The 

exporting is performed by creating “Tasks”. Each task is creating a different exported 

file with information that the user has defined. Clicking on the Tools, Export Events 

Automatically sub menu item will bring up the Export Tool for Transaction window. 

 

Figure 9-3-1 

Name: Exporting task name. 

Enable:  Tasks is saved and enabled, running or scheduled to be running. 

Runnable:  Task was already executed in the past. 

Executed:  Executing. 

Status: Status of the task. 

Last Export: When was the last time the task was run. 

Next Export: When is the next time the task will run. 

9.3.1 New Task 

When clicking the “New Task” button the “Export Data Wizard” screen will appear. 

 

Figure 9-3-2 
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Click “Next” to select the type of data required to be exported. The current options are 

Card Events, Personnel Card Information and Test Data, for example Card Events will 

be selected. 

 

Figure 9-3-3 

Select the Department then click “Next”. 

 

Figure 9-3-4 

Select the Record Type and the Event Type(s) then click “Next”. 
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Figure 9-3-5 

Select the Fields to be exported (or all fields) and click the right arrow button to move 

them across to the righthand panel then click “Next”. 

 

Figure 9-3-6 

Tick the Title check box if the Fields Name is to be the first line in the file before the 

events. 

Enter the path (folder) the exported file will be placed. Click on the 3 dots to the right 

of the Path of Exporting File and select a location to save the file. 

Select the file format (MS-Excel, TXT, RTF, HTML etc.). Select the separator to 

separate between the different fields which were selected in Figure 9-3-6. 

Enter the File name and click Next. The next screen in the Export Data Wizard will 

open. 



 138 

 

Figure 9-3-7 

 

Figure 9-3-8 

Select the Departments/Sub Departments/Time Period/Doors/Record Type/Events that 

are required to be exported. 

A user can decide if the task should run immediately or scheduled for later. Set the 

task Name and Enable it if is required to be run immediately. Set the Frequency to be 

Daily/Weekly/Monthly. Set the Daily frequency to be one time or periodically (as 

frequent as every minute). Keep Time will set if we limit the period of exporting to 

certain dates or infinite. If the export is successful then the success window will 

appear. 

9.3.2 Delete Task 

Delete the selected task. 

9.3.3 Edit Task 

Allows the user to edit the task details. 
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9.4 Language Editor 

Clicking on the Tools, language editor Tools sub menu item will bring up the 

language editor Tools window. Language editor screen can set any type of language to 

the software with a language development package. 

 

Figure 9-4-1 

9.5 Database Converter from Secusys 

Clicking on the Database Converter from Secusys Tools sub menu item will bring up 

the Database Converter from Secusys Tools window. It will import these other data 

from Secusys MS-ACCESS database. Secusys will be closed before exporting. 

 

Figure 9-5-1 
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9.6 Capture Tool 

The Secusys software allows taking pictures of Personnel or Visitors using a web 

camera or Digital camera. Click on the Tools, Capture Tool sub menu item, the 

camera screen will appear. If a blank camera screen appears then the camera is not 

working. Check the camera connections and make sure the correct software drivers 

are loaded. 

 

Figure 9-6-1 

A user can take photos which will be stored in the “Photo” folder inside the folder of 

Secusys. The user can also setup the camera, adjusting its parameters. Note that prior 

to using this feature the camera is connected to the PC and camera driver is already 

installed and operating. Click the “Capture” button for capturing the image on the 

screen. 

9.7 Card Printer 

Clicking on the Tools, Card Printer sub menu item will open the Card Printing 

Module.  
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Figure 9-7-1 

 

 

Figure 9-7-2 

 



 142 

Chapter 10 window 

The window menu allows an installer to setup desktop and choose screen style. 

 

Figure 10-0-1 

10.1 Save Desktop 

Clicking on the window, Save Desktop sub menu item will open the Module. Input 

the name as “first”, click OK to continue. Then you can see the first desktop under the 

window menu. 

 

Figure 10-1-1 

 

Figure 10-1-2 

10.2 Delete Desktop 

Delete the desktop the user created. 

 

Figure 10-2-1 
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10.3 Screen Style 

Clicking on the window, Screen Style sub menu item can be checked to change the 

style of main window. The style including the standard style, NET style, office style, 

XP style. 

 

Figure 10-3-1 

And the user can choose to show caption of quick bottom or not. 

 

Figure 10-3-2 
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Chapter 11 Help 

The help menu allows an installer to find help in the screen. 

 

Figure 11-0-1 

11.1 Help 

For future use. 

11.2 Home Page 

Clicking on the help, home page menu item will open the website www.keyking.net. 

The users can find many information about the company. 

 

Figure 11-2-1 

11.3 On-line Update 

For future use. 
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11.4 License Information 

The License Information screen reads and displays the contents of the Hardware Key 

or Software Dongle. The Hardware Key is used to give access to additional modules, 

doors, panels and clients and is unlocked for additional functions once these functions 

have been purchased. 

 

Figure 11-4-1 

11.5 Update License 

Before you upgrade license, you have to know which kind of license 

you are using. 

⚫ Virtual license: No need a hard dongle, and the SN of license will be 

following the CPU and motherboard of the computer. 

⚫ Dongle: real hard dongle. 

 

1.15.1 Upgrade Virtual license 

Get License:  

Click “Help”, and choose “License information”, you will see the 

license you are using. You will get the Serial Number of the license, now 

you have 2 options to give back all information to your supplier. 

⚫ Option 1#: Copy this License Information picture, and send to your supplier. 
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⚫ Option 2#: Export License, click the “Export license” to save all information. For 

example: 1679000840502600.txt, then send “1679000840502600.txt” to your 

supplier. 

     

 

Upgrade License:  

Click “Help”, and choose “Upgrade License”, and choose the license 

file “1679000840502600.txt” got from your supplier. Click “Ok”, you will 

get “Success to upgrade license” message. 
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1.15.2 Upgrade Dongle 

Read Current License:  

1. Run Secusys, and plug the dongle needs to be upgraded properly. Check the current 

dongle information through "Help/license Information". 

                 

               DGV30 Dongle 

 

2. Send this picture to your supplier. You have to remember this Serial Number of 

Dongle, and send it to your supplier. But you'd better send this whole picture to him, 

will be easy for him to distinguish all information. 
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    Serial Number of Dongle                                                              

DGV30 Dongle 

 

You may pay for it, then you will get a new Registration File for this dongle from 

your supplier. 

 

Upgrade License:  

3. Click “HELP” on the Menu Column, then click “Dongle Upgrade” option, please 

refer to flowing screenshot for reference. 

 

4. Choose the new Registration File for this dongle, and click "Open". 
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5.  Click OK, software will finish Dongle Updating. You will see below picture if 

your dongle updated succeed. 

  

11.6 About 

The About menu option lists software details such as the Version number and the last 

build time plus Secusys contact details. 

  

Secusys, No CardList version, 4 Bytes            Secusys, No CardList version, 8 Bytes 

Figure 11-6-1 
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Chapter 12 Language 

The language can be selected at the time of installation and subsequently changed 

once the software has been configured. To change the language from within the 

software, click the “Language” menu button and click on the required language. The 

language will change within 5-10 seconds, there is no need to restart the software. 

 

Figure 12-1-1 

 

 


